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Overview

This manual describes how to use the client software that is part of the iManage
DeskSite product. For information on the administrative utilities provided with
iManage DeskSite, please see the iManage Server Administrative Manual For
installation guidelines and instructions, see the iMarnage Implementation Guide.

The iManage DeskSite User Reference Manual 1s intended for end users of iMan-
age DeskSite. It covers the functions and operation of the iManage DeskSite pro-
gram and the operation of Windows applications that are integrated with
iManage DeskSite. The manual also describes in detail the operation of the iMan-
age View and Portable programs.

How to Use this Manual

Users new to iManage DeskSite should read Chapters 1-5 to gain an understand-
ing of iManage DeskSite and how to use it. Users familiar with an earlier version
of iManage DeskSite can skim Chapters 1 and 2, then review the sections of
Chapters 3, 4 and 5 that describe new features or changes to the iManage
DeskSite program.

Chapters 6, 7, 8, and 9 describe special topics relevant to users of iManage
DeskSite. You should consult these chapters as their content becomes relevant to
your work.

Summary of Chapters

Chapter 1 provides an infroduction to document management systems and iMan-
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age DeskSite.

Chapter 2 describes iManage DeskSite’s main program interface.

Chapter 3 describes iManage DeskSite’s basic document management functions.
Chapter 4 describes how to perform searches in iManage DeskSite.

Chapter 5 describes how to use iManage DeskSite from within ofher Windows
applications.

Chapter 6 describes the advanced features of iManage DeskSite.
Chapter 7 describes how to use the iManage View program.
Chapter 8 explains how to use the iManage Portable program.

Chapter 9 explains how to use the document echoing option in iManage
DeskSite.

What is a DMS?

Who Needs a DMS?

12

A document-management system (DMS) is soflware and/or hardware that man-
ages repositories of millions of documents for hundreds or thousands of users.
Document-management systems can provide the following benefits to your orga-
nization:

+  Easily manage online repositories that store millions of documents

= Sophisticated tools for quickly finding documents without manually search-
ing file servers

+  Consistent, system-wide document security

+  Ability to share documents with other users securely and easily
«  Creation and tracking of multiple versions of a document

»  Extensive document history and audit trails L

«  Automatic archiving and restoration

At organizations that do not use 2 document management system, file storage and
retrieval looks something like this:

+  The most common way to identify a documnent is through document names.
Despite efforts to enforce file naming conventions, document names still
tend to be arbitrary and often do not reflect the contents of documents.
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Hence, it is often difficult to find necessary documents, once the file name
and directory have been forgotten.

«  Documents are scattered on the file server. A single file server may contain
thousands of directories and tens of thousands of documents. For this same
reason, it is difficult to find and to share documents among users.

*  To create new versions of documents, users must rely on providing a differ-
ent name for the existing document. Tt is not possible to generate a report
describing when and which users revised a particular document. Applica-
tions do not keep track of document versions or who made changes to a par-
ticular document.

+  The ever increasing number of documents prevents users from locating
required documents. Staff members spend increasing amounts of time locat-
ing information, and documents have to be repeatedly generated because the
original versions cannot be located.

«  Document security is left to individual users. Unauthorized access is a com-
mon problem.

»  Itis difficult to determine which documents are ready for archiving or which
ones are in use. Users do not delete old documents and thus end up wasting
network resources.

+  Users cannot locate needed documents once they are archived to secondary
storage.

What Is iManage DeskSite?

iManage DeskSite is an enterprise-wide, mission-critical DMS. With iManage
DeskSite, you can greatly simplify the task of managing repositories of millions
of documents and making them available to thousands of users. iManage
DeskSite provides users with the fellowing kinds of functions:

1. Search repositories of millions of documents

Search for documenits based on document content

Share documents with other users

Search for and open documents from within major windows applications

Checkin and checkout documents

Create new versions of documents

e R T

Track document usage and history
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n Product Features

Document Profile Information

14

Each document in an iManage library has its own document profile record. The
information included in a document’s profile record can include:

»  the author

«  the operator who entered it into the library

«  the date of creation

«  the version number

»  the user who last edited it

* alengthy description of the document

»  ashort description of the document

. comments

«  customn classifications used to identify, differentiate and group documents in

the library.

The information contained in a document’s profile record enables you to search
quickly for documents that you need without having to remember obscure file
names or where the documents are stored on the file server.

Table 1.1 lists the kinds of information that can be contained in the profile record

for a document.

Table 1.1: Document Profile Information Fields and Descriptions

Nufnber .

Unique number autométicélly assigned by iManage

DeskSite
Version Version number of the document (1—999)
Description Textual description of document, wp to 254 characters
Name Short name of document, up to 16 characters
Type Document Type is usually based on the application that

was used to create it
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Table 1.1: Document Profile Information Fields and Descriptions

Author Author of the document has maximurm security rights, and
is Novell Owner of the document

Operator Operator of the docurnent has read/write access, and can
set document access rights

Class General class of the document, defines default settings,
user defined

Client Client is a custom classification used to identify the docu-
ment.

Matter Matter is a custom subclassification used to identify docu-

ments. It is dependent on the entry for Client

Custom Fields Captions of custom fields can be customized

Creation Date Date document was created or installed

Last Edit Date Most recent date when document was edited

Last Edit Time Most recent time when document was edited

Last User Name of the user who most recently edited the document
Size Size of the document in number of bytes

Retain Days Number of days before inactive document is archived
Index Flag Marks whether the document should be full text indexed
Comment Comment associated with the document, up to 8,000 char-

acters, fully searchable

Note: The fields included in a document’s profile record can be customized
extensively, so some of the items listed here may not be included in your docu-
ments’ profile records, or different fields may be included that do not appear
here.

Document Security

Sharing your documents with. other users becomes a secure and easy task with
iManage DeskSite. Each document in an iManage library has a custom set of
security settings that determine who can access the document and to what degree
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they can access it

To share your documents using IManage DeskSite, you select which users should
have access to them and select to what degree they should have access to them.
Users can be granted read-only access, which allows them only to view the doc-
ument, or read-write access, which allows them to view and edit the document.
They can also be granted no aceess to the document, in which case they cannot
even locate the document in the library. You also specify a default security set-
ting for the document, which determines the level of access available to users not
specifically granted or denied access.

Pages

If Pages have been created using the iManage WorkSite application, you can see
the Page hierarchy in the folder tree, the integration dialog, and the browse for
folders dialog. You cannot create Pages in iManage DeskSite.

Folders

With iManage DeskSite, you can create groups of documents that are related
together and named as Folders. Folders can be made PRIVATE or PUBLIC,
depending on who needs to access them. When you create a folder, you can set
folder security to inherit security settings from the parent folder.

By grouping documents into folders, you can easily organize decuments without
having to physically move them around or store them in the same place. The list
of documents included in the folder can be displayed at once by clicking on the
folder icon for the folder. : :

Worklists

Each iManage server that you are logged into has a worklist icon associated with
it. By clicking on the Worklist icon, you can redisplay the forty documents that
yvou used most recently in the library. By clicking on your Worklist, vou can
quickly access the docuinents you need and use the most. By default, documents
in the Worklist are sorted by the most recent date you accessed them.

Related Documents

In addition to grouping documents in Folders, you can create relations between
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documents to keep related materials together, such as a contract and an addenda.
For example, a contract could be related with the addenda to the contract or to
other documents used to create it.

You can create relationships between docurments through an intuitive drag-and-
drop user interface. An icon in the iManage DeskSite desktop indicates docu-
ments that are related to other documents.

Saved Searches

iManage DeskSite provides powerful searching capabilities to help you find your
documents. You can search for documents according to document profile infor-
mation, the full text of document comments, or the full text of documents them-
selves. After you perform a search, you can save your search results for later
immediate reference by clicking on the icon for the saved search. You can also
share your saved searches with other users by marking them PUBLIC.
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iManage WorkSite’s Middle Tier Server

Clients and Servers

With iManage DeskSite, users access documents by logging into a machine
called a WorkSite Middle Tier Server, which in turn provides them with access
to documents stored in iManage libraries. The WorkSite Middle Tier Server
machine is called a “server” because it performs operations for other PCs. In this
case, the WorkSite Middle Tier Server delivers documents to users’ PCs and per-
forms-searches for documents across the network. PCs that are the recipients of
services from the server machine are referred to as Client PCs. Client PCs have
iManage DeskSite’s user software installed on them, which enables them to con-
nect to the WorkSite Middie Tier Server.

By connecting to remote libraries through the WorkSite Middle Tier Server,
many users can access these libraries while minimizing the number of long-dis-
tance connections that need to be maintained between locations.

Ty
7 S
- | Documents
= = -
User PC Middle Tier Server —
(Client) e
Documents
—

City

Figure 1.1: How a user accesses documents through iManage DeskSite.
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What is an iManage Library?

‘When we refer to an iManage Database, or Library, we are actually talking about
a library that includes three distinct entities. Each iManage library is actually
composed of these three parts:

«  a fileserver, which stores the actual documents

*  aset of information tables, or database, that stores information about the
documents

+ aset of index collections of the full text of documents in the library, which is
used for searching '

These three componenis — the fileserver, the information tables, and the full text
index — work together to organize and index your documents. From a user’s
standpoint, though, they operate as a single entity, or library, with a single name.

iManage DeskSite User Programs

There are three user programs provided with iManage DeskSite:

+  iManage DeskSite, which is the main interface between users and iManage
Libraries
+  iManage View, which allows you to view multiple documents at once

»  iManage Portable, which enables you to access documents while not con-
nected to the library
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Overview

The iManage DeskSite Desktop window is modeled on the Windows Explorer
and Outlook user interfaces and contains several display frames, menus and tool-
bars:

+  Shortcut frame: contains icons for shortcuts to important folders

+  Tree frame: organizes and displays information about servers, libraries,
folders and searches

*+  Document grid: displays a document list that is either the result of search or
the contents of folders

*  Document Results frame: displays various infonmation in tabular display
areas about a particular document

*  Menu Options and Toolbars: provide the functionality to perform every-
day tasks in IManage

*  Web Browser: provides access to the web directly from the iManage
DeskSite Desktop - :
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Figure 2.1: iManage DeskSite 5.0 Desktop Window

Shortcut Frame

The Shortcut frame contains shortcuts to frequently used folders. This pr0v1des
fast navigation to your most frequently used folders and searches.

Two default shortcuts exist when you install the system:

*  Worklist shortcut: Performs a search for the last forty documents that you
used or edited.

+  Checkedout Documents shortent: A list of the documents you currently E
have checked out !

To add a shortcut to the Shortcut frame:

Click the desired folder or saved search in the Tree frame and drag it to the Short-
cut frame. Then you only need to. double-click the shortcut icon to display the
contents of the folder or search. This can eliminate significant folder navigation
time.

To add a document to your shortcuts:

Click the desired document in the Document Grid and drag it to the desired
folder in the Tree frame. The documnent appears in the Document Grid list when
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you click the icon in the Shortcut frame,

Shortcut Groups
You can organize the shortcuts you setup into Shorteut Groups. Clicking on the
Shortecut bar opens these groups. The top shortcut bar, named iManage, is a
default group and cannot be removed.
To create a new Shorteut Group:
1. Right-mouse click the iAfanage shortcut bar
2. Select Add Group from the pop-up menu.
3. Type the name of the new group in the space provided. Press Enter when
vou are finished,
To remove a Shortcut Group:

Right-mouse click anywhere in the desired shortcut group and choose Remove
Group from the pop-up menu.

Tree Frame

The Tree frame contains the organizational structure of all servers, libraries,
iManage WorkSite pages if any, folders, worllists and saved searches.

The iManage Desktop window’s Tree frame contains the following components:
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Figure 2.2: Tree Frame

Servers

In iManage DeskSite 6.0 and later you can log into more than one server at a
time. Each connected server has its own Tree Frame of libraries, folders, search
histories and worklists. Click the server tabs at the bottom of the Tree Frame to
access each server.

Within the tree frame of each server are the following four components:

Checkedout Documents
Click on the Checkedout Documents icon to display a list of all documents cur-
rently checked out by the user. The docwmnents appear in the Document Grid.
@ Worklist

The second icon in the tree frame is the Worklist. This is a shorthand way of per-
forming a search for the forty documents you have most recently used or edited
on a particular server. The documents appear in the Document Grid.
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Pages

Search History

The third icon in the Tree frame is the Search History. You can quickly re-run
searches recently performed in iManage DeskSite by clicking on the appropriate

flashlight icon %, displayed under the Search History branch of the tree frame.
The Search History icon only retains searches performed during the current ses- .
sion. Clicking on a flashlight icon performs the search again using the same
search criteria originally entered.

Library

One library icon appears for each library available to you in a particular Server
tab. They may not all be visible at once in the Tree frame, so a vertical scroll bar
along the border of the frarme on the right lets you bring additional libraries and
associated file folders into view.

If Pages were created in the iManage WorkSite application, you can see the page
structure in iManage DeskSite. You can access documents from folders on these
pages and perform all activities on them that you can perform to documents in

other folders. The activities you can perform depend on your Role and the access

rights you have to the Pages and Folders. You cannot create Pages in the iManage
DeskSite application.

Folders and Sub-folders

Libraries contain folders, which are static groups of documents you can create or
share with other users. Folders provide 2 method for organizing and sharing doc-
uments easily. To display the contents of a folder, click the icon for that folder
and the documents within it appear in the Document Grid.

Creating a folder

To create a new folder, right click the icon for the library in which you want to
create a folder. To create a sub-folder, right click the folder icon. You must have
authority to create a sub-folder within that folder. The owner of the folder sets the
security wupon creation and can grant security options to other users. See “Folder
security” on page 26. You can create sub-folders under other users® folders if you
are given authority to do so. Your iManage administrator can disable the ability
to create sub-folders under other users’ folders. The Create New Folder dialog
box appears requesting a folder name and folder description and naming the use-
tid of the folder owner.
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Figure 2.3: Create New Folder dialog -- General tab

Folder security

When you create a sub-folder, it has the same security settings as the parent
folder by defanlt. You can change these settings if you wish by deselecting the
Inherit permissions from pafent checkbox. If your role does not allow you to
create public folders, you cannot access the security tab.
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Eresy Rights:

Full Accass

Figure 2.4: Create New Folder dialog -- Security tab

»  Ifyou select Private as your default security setting on the folder, then only
you and other users or groups to whom you specifically grant access to the
folder can see it. '

+  Ifyou select Public, then all users, except those specifically denied access,
can add documents to the folder or remove documents from the list of those
contained in the Folder.

» Ifyou select View, then all users, except those to whom you specifically
grant Modify or No Access, can view the folders contents, but cannot add or
remove documents from the folder, (i.e., view access restricts users from
changing the list of documents that constitute the contents of the folder).
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Figure 2.5; Create New Folder dialog -- Security tab -- Permissions not inherited
from parent folder

You can also specify greater or lesser access privileges for specific users and
groups by making a selction from the Type of Access drop down list. The access
privileges that you grant to specific users and groups using the Type of Access
drop down list are EXCEPTIONS to the general security settings you selected for
this folder. o

*  No Access--Cannot see the folder.

*  Full Access--Can set security on the felder, add or remove items from the
folder, create subfolders, and delete the folder.

+  Read--Can view documents in folder, but cannot add or remove them.

+«  Read/Write--Can add or remove documents from the folder and create sub-
folders, but cannot change folder security.

28 AUT0020028



Chapter 2: Using the DeskSite Desktop Window

Note: The security settings on a folder only determine two things: (1) whether or
not a user can see the folder; and (2) whether or not the user can add or remove
documents from the folder. Whether or not a user can EDIT a document or only
view it is defermined by the security settings for the document, not those set on
the folder. Depending on the access privileges set on the documents contained in
a folder, a particular user may or may not see any documents contained in the
folder, may have read-only access to the documents, yet be able to add docu-
ments to the folder, or may be abile to edit documents contained in the Folder, but
cannot add documents to the folder. For more information on document-level
security, see “Setting Access Privileges” on page 55.

Deleting a folder

To delete a folder that you created or have Full Access to, click the folder so that
the folder name is highlighted, then press the Delete key. A Confirm Delete dia-
log box appears, asking you to confirm that you wish to delete the folder. Click
on OK to delete the folder.

Note: Deleting a folder does not delete its contents, only the folder.

Adding Documents to a Folder

You can add documents to a folder that you created, or have Full Access or Read/
Write access to. Use drag-and-drop technique to add documents already in the

library:
1. Inthe Document Grid, highlight the document you want to add.

2. Click again on the document row, keeping the left mouse button depressed.
The pointer becomes a document icon.-

3.  With the left mouse button depressed, move the pointer to the right of the
appropriate folder icon in the Tree frame.

4. Release the mouse button. The document is added to the folder that you
selected.

Importing Documents to a Folder

1. Highlight the folder where you want to import a document.

2. Select Import from the File menu.
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3. Navigate to the document you want to import and highlight it.
4. Click Open.

5. Complete the New Document Profile dialog.

6. Click OK.

Editing the Properties of a Folder

Once you create a folder, you can edit its properties — name, description, and

security (i.e., whether it should be public or private}. You can also edit folders

created by others if you have been granted Full Access to those folders. To edit
the attributes of the folder, right-click on the folder icon and select Properties
from the popup menu. Only the owner of a folder or a user to whom the owner
has granted Full Access can edit properties.

To change only the name of the folder, highlight the folder and press F2. Enter
the new folder name and press Enter.

Saved Searches ’

A library may have saved search icons that contain search criteria that have
been saved for later use. Saving searches allows you to perform routine searches
of the library without having to reenter common search criteria. Clicking on a
search icon causes the search to be performed again. The documents found dur-
ing the search are displayed in the Document Grid. See Chapter 4 for specific
instruction on creating a Saved Search.

Deleting a Saved Search

You can delete a Saved Search that you created in much the same way as you
delete a folder that you created. Click on the icon for the Saved Search, then
press the Delete key. Deleting the Saved Search does not delete the documents
displayed in the search; it only deletes the search profile from the tree frame.

Opening and Closing Nodes in the Tree Frame

30

Nodes are the plus and minus syrbols appearing throughout the tree structure
wherever there is a branch. Clicking the minus symbol changes it to a plus and
vice versa. When a minus sign appears in the node, you can see the tree structure
beneath the icon to the right of the node; when a plus sign appears in the node,
the tree structure is collapsed and you cannot see it. You can see the entire tree
structure when all nodes are minuses.
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Note: The security settings on a folder only determine two things: (1) whether or
not a user can see the folder; and (2) whether or not the user can add or remove
documents from the folder. Whether or not a user can EDIT a document or only
view it is determined by the security settings for the document, not those set on
the folder. Depending on the access privileges set on the documents contained in
a folder, any given user may or may not see any documents contained in the
folder, may have read-only access to the documents, yet be able to add docu-
ments to the folder, or may be able to edit documents contained in the Folder, but
cannot add documents to the folder. For more information on document-level
security, see “Sefting Access Privileges” on page 55.

Navigating in the Tree Frame without a Mouse

+  Up and Down arrow keys move cursor in up and down in tree

+  Left and Right arrow keys function to open and close nodes in the tree

+  Enter selects a Worklist, Folder, or Saved Search, as if yvou clicked on it.

Note: When you select a Worklist, Folder or Saved Search, focus automatically
shifts to the Document Grid, enabling you to use keyboard shortcuts to navigate

in that frame as well.

Document Grid

The Document Grid displays the resulfs of an iManage DeskSite search, worklist

or the contents of a folder.

B B mar

Telephone List: 1,012,633
Documert2 1,000,247
Documert 21,265
ACCAQ04) 1,013,536
Docurment2 60,072
docurment1 52,095
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2 DIPALI PUBLIC
1AL DO
1 DCHAN PUBLIC
1 DCHAN PUBLIC

.,

] 00011 £65:06
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012772000 6:27:42 PR
12/09/1999 4:03:01 PM
12/08/4999 6:15:20 PM
10/111999 11:57:20 AN
09014998 51232 P

Figure 2.6: The Document Grid
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Sorting Documents in the Grid

To sort the contents of the Document Grid by any column, just click the desired
column heading. To sort in reverse order—that is, from ascending order to
descending or vice versa—click the heading again.

Document column

The left most column in the Document Grid is the document icon column which
displays an icon representing the document type. You cannot remove this column
from the document grid.

Status column

This column displays icons to indicate the current status of the document. You
cannot remove the status column from the document grid. The icons that may
appear in this column are:

=] The document is archived.

The document is checked out.

The document is locked.

& W

The document has other documents related to it.

Sclecting Documents

Clicking on a document in the Document Grid highlights the document in blue.
You can select multiple documents by keeping the Ctrl key depressed and left-
clicking the desired documents. You can select a range by depressing the Shift
key and then left click on two documents in the grid; those two documents and all
those in between are selected. If you are unable to use the keyboard and mouse
simultaneously, we recommend enabling Sticky Keys, which is available in Win-
dows 98 and 2000 and Windows NT. Enable Sticky Keys from the 4ccessibility
Options Control Panel which comes installed with your Windows 98 and 2000
and Windows NT operating system. :

Performing Actions on Documents

With iManage DeskSite you can perform a variety of actions on the documents
listed in the document grid. Execute these actions by:
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*  Highlighting the desired document(s) and clicking an icon in the toolbar
icons at the top of the Desktop Window. (See “Menu Options and Toolbars”
on page 38 for more information on the toolbar)

*  Highlighting the desired document(s) and selecting an option from the Doc-
ument menu (see Figure 2.6). :

*  Accessing the document menu with a right-mouse click on the desired docu-
ment.
Customizing the Document Grid and Profile

You can configure the Document Grid in several ways so that it displays the
information you want in the format you want. You can customize the Display
Columns and the Profile Fields that appear in the Document Grid.

To Customize what columns appear:

1. To do this select Options from the Options menu. This launches the Con-
figure dialog box (see Figure 2.7).
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Figure 2.7: Configure dialog, Select Profile Fields tab

2. Choose the Select Profile Fields tab.

3. Add fields you want to see as column headers in the Document Grid from
the Available Fields list to the Display Column Fields or the Profile Fields

list.

4. Remove fields you do not want to see as column headers in the document
grid from the Display Column Fields or the Profile Fields list to the Avail-

able Fields list.
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Note: The Profile Fields list in the lower right corer of this dialog determines
which profile fields display in the Document Profile tab of the Document Results
Frame in the lower-right portion of the main desktop window.

5. Click OK when finished.

Customize Display Options Defaults:

Select Options from the Options menu. This launches the Display Options
dialog (see Figure 2.8). Then choose the Defaults tab. There are two features to
customize in the Document Grid:

Figure 2.8: The top portion of the Displgy Options dialog, Defaults tab.

*  Select the maximum number of searches to appear in the Document Grid.
This will prevent an overwhelmingly large search refurn impacting the per-
formance of your system.

*  Select whether vou want the Document Grid to contain only the latest ver-
ston of each document or show all versions.

Navigating in the Document Grid without a Mouse

Up and Down arrow keys move the cursor up and down in the grid. The Page Up
and Page Down keys also move the grid up or down.

Document Results Frame

The Document Results frame provides information about a particular docutmnent.
There are five tabs:
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hDucument Profile /i Quick View " - Related Docurents

Figure 2.9: The Document Results Frame tabs

Switching Tabs in the Bottom Pane of the Document Grid

Ctrl+Tab switches from tab to tab in the bottom pane of the Document Grid.

Document Profile Tab

You can view a document’s profile by highlighting a document in the Document
Grid and then clicking the Document Profile tab. You may not edit any of the
fields appearing in this tab. To edit profile fields you must launch the Edit Profile
dialog.

Which profile fields appear in this tab is determined by the settings of the Profile
Fields list on the Select Profile Fields tab in the Configure dialog, launched from
the Options menu.

Quickview Tab

To view a document without leaving the iManage Desktop, highlight the docu-
ment and click the Quickview tab. You can also right-click the desired document

and select Quickview from the pop-up menu or click the Quickview icon =3
from the toolbar. A read only image of the document appears in the QllleVlEW
tab.

Related Documents Tab

To see a list of 2 document’s relations, highlight the document and click the
Related Documents tab. You can also right-click the desired document and select

Related Documents from the pop-up menu or click the Related icon 15| from
the toolbar. A list of the document’s relations appears in the Related ‘Documents
tab.

Document Versions Tab

36

To see a list of a document’s versions, highlight the document and click the Doc-

ument Versions tab. You can aiso right-click the desired document and select
ik

Versions from the pop-up menu or click the Version icon f{%4{ from the toolbar. A

list of document’s versions appears in the Document Versions tab.
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History Tab

To see a list showing events in the document’s history, highlight the document
and click the History tab. You can also right-click the desired document and

select History from the pop-up menu or click the Version icon E}%ﬂ from the tool-
bar. A list of activities performed on the document appears in the Document His-
tory tab. The history tab shows such activities as Create, Checkout, Open,
Checkin, Print, Modify, Location of the activity and comments about certain
activities. :

Document Results Frame PushPin

The PushPin allows you to control the relationship between the Document Grid
Frame and the Document Results Frame. Depending on the PushPin state, the
Document Results Frame behaves differently when you click on an item in the
Document Grid Frame. You can set the PushPin separately for each tab in the
Document Results Frame. Your iManage Administrator can set the default state
and disable certain states.

Up All tabs Goes blank

Down All tabs Automatically
refreshes
Locked Related Documents | Stays the same as

before you clicked
on another item
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Menu Options and Toolbars

38

The following table shows the keyboard shortcuts and toolbar buttons for fre-
quently used functions in iManage DeskSite. Menus are customizable by your

system administrator, so some options may not appear or may have different

names.

Table 2.1: iManage Toolbar

Search

Refresh Fs.
Print Document List -
Print Preview . _
Open Ctri+O
Edit Profile Ctr+E
Versions Ctrl+S
Quickview Ctrl+Q
View —
Hi#tow Ctri+H
Related Docs Ctrl+R
Checkout —
Checkin —

Send Document URL

Unlock
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Table 2.1: iManage Toolbar

Remove from Folder

Import

Export

Purge

Synchronize Echoed
Documents

Set New Document
Default

Setup Local Applica-
fions Table .

Security Template

Set Security on Multiple
Documents

Change Password

Send Document

Send Link - C o

Copy Document

Copy and Open Docu-
ment

Create New Version

Create New Version and
Open

Print Selected Document
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Table 2.1: iManage Toolbar

Checked Out Informa- | —
tion

Customizing Toolbars

40

iManage DeskSite allows users to both edit the default toolbar and customize
new toolbars.

Select Customize Toolbar from the Options menu or right-mouse click on
the toolbar you wish to customize and select Customize. .. from the pop-up
menu. The Customize dialog will launch displaying a Toolbars tab and a Com-
mands tab. ‘

In the Toolbars tab of the Customize dialog you can:
»  Activate or deactivate the toolbar on your desktop by highlighting the tool-
bar in the list and checking or unchecking the checkbox.

*  Create a new toolbar by clicking on the New button. You are asked to give
the toolbar 2 name.

*  Delete a customized toolbar by highlighting the desired toolbar and clicking
the Delete button. {You cannot delete the iManage toolbar)

»  Reset the iManage toolbar back to its original state by highlighting it and
clicking the Reset button.

+  Activate the tool tips checkbox which will popup the button name when the
mouse pointer hovers over a button.

»  Activate the 'cool look' checkbox to display buttons in a different way. = _

In the Commands tab of the Customize dialog you can:

Select from various toolbar categories. iManage DeskSite has one default cate-
gory called iManage. Your system may have others. When a category is high-
lighted, the available buttons appear to the right of the Categories list.

Build a toolbar by dragging and dropping button commands from this Com-
mands tab to the desired toolbar on your desktop. Remove a button from the tool-
bar by dragging and dropping the button from the toolbar back to the Commands
tab.
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Web Browser

iManage DeskSite has a web browser utility to allow vou to quickly access the
web directly from the iManage Desktop. When launched, the browser takes over
the space occupied by the Document Grid and Document Results Frame. To pro-
vide more web-browsing space, de-select Shortcut Bar option in the Options
menu. You can also use standard mouse-based Windows re-sizing techniques to
create a larger browsing space.

Web Browser Toolbar

Address Field: €11/ imanage con/

Type in a standard web address, or select from a previously selected address by
using the drop-down arrow, and the site launches.

Arrow Commands:

These commands help you navigate backwards and forwards. The forward button
will only be available if you have navigated backward at some point during the
current browsing session.

Reload Command:

This will refresh the currently loaded page and include any changes since the last
time you loaded the page.

Stop Command: [

If a page you are trying to load is taking too long to display, you can cancel it by
clicking the Stop icon on the toolbar.

Home Command:

Your browser’s home page is the page that first appears when you launch the web
browser. You can return to this page at any time by clicking on this Home jcon.

To change your home page in Microsoft Explorer launch the MS-Explorer appli-
cation and select Internet Options from the View menu. Type in your home
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page address in the space provided in the General tab,

Search Command:

This command will launch the Microsoft search engine at Microsoft’s main web
site.

Favorites Menu:

The favorites menu contains standard Explorer functionality to add and organize
favorite web sites that you visit repeatedly.
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Overview

This chapter describes the basic document management functions available in
iManage DeskSite. These include:

*  Connecting to WorkSite Middle Tier Servers
»  Opening documents

*  Viewing documents

*  Searching for documents

*  Checking out documents

*  Checking in documents

«  Relating documents to one another

*  Working with muliiple versions of docurnents
*  Copying documents

*  Sending documents and document attachments
*  Importing documents

»  Exporting documents

»  Entering and Edifing Profile Information

+  Setting Access Privileges on a document

*  Viewing document history

+  Unlocking documents

*  Deleting documents

+  Restoring Archived Documents

«  Changing passwords
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Note: For information on more advanced functions, see Chapter 6, 7 and 8 in
this manual. For information on using iManage DeskSite from within an inte-
grated application, see Chapter 5. The iManage Integrated Desktop window,
which is available by selecting Open from the File menu in integrated applica-
tions, is described in detail in Chapter 5. ‘

Connecting to WorkSite Middle Tier Servers

Your first step in using iManage DeskSite is to register any WorkSite Middle Tier
Servers you wish to connect to. The WorkSite Middle Tier Server is how you
gain access to your documents and databases. To register and log into a WorkSite
Middle Tier Server, you need a valid Login, Password and Server name:

1. Select Register/UnRegister from the Login menu. This launches the
Register Servers dialog,

Figure 3.1: Register Servers dialog. The icons show which servers are con-
nected. In this illustration, BOSTON and CHICMS.IMANAGE.COM are con-
nected and PARJS is not.

The dialog shows a list of all the servers that are registered. A check in the
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checkbox indicates that the server is set to log on automatically when you
open iManage DeskSite. You can select which registered servers to log into
by checking or unchecking them.

To disconnect from a server to which you are currently connected, highlight
it and click Disconnect. You will not lose the login information you have
already entered for that server.

To reconnect to a server to which you are not currently connected, highlight
it and click Reconnect.

To change login information for a server, highlight it and click Unregister.
Then register the server again.

2. Enter the name for the WorkSite Middle Tier Server or the Server Cluster in
the Enter Server Name: field and click Register. This launches the server
Login dialog.

Figure 3.2: Login dialog

Note: Your servers may be set up in a server cluster arrangement that includes
multiple servers serving the same iManage libraries. The multiple servers pro-
vide additional fault tolerance in the event of a server failure and enhanced per-
formance. You log into a cluster the same way you log into an individual server.

3. Enter your userID and password in the UserID and Password fields.
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Note: For security reasons, you must enter your UserID and Password correctly
in a limited number of attempts. Your iManage administrator sets the number of
attempts you can make before the system locks you out. If this happens, contact
your iManage administrator to reset your password.

4. If you want to log into this server automatically when you open iManage
DeskSite, cheke Auto Login,

5. If Trusted Login is enabled by your Administrator and you want to use this
feature, check Use Trusted Login. When you check this box UserID and
Password are blanked out.

6. Then click Login. If you have entered authentic login information the Server
appears in the list box of the Register Servers dialog.

Note: You can repeat these steps for as many Servers as you would like to Reg-
ister for current or future use. From the Regisfer Servers dialog you can connect
te or disconnect from any of the registered servers. At the startup of the iManage
application, only connected severs are antomatically logged on.

Trusted Login Option

The Login dialog box also presents you with the option of using your network

login ID to log into the WorkSite Middle Tier Server. To use this optioin, check

the Use Trusted Login checkbox. The User and Password entry boxes are :
locked out if you check this box.

Note: Your administrator must specifically enable this option. If you try to use
this option and receive an error message, try logging in without using the Trusted
Login option, ’

Connecting to an Additional WorkSite Middle Tier Server

To connect to a different WorkSite Middle Tier Server, open the Register/UnReg-
ister Servers dialog and select from the available registered servers (or register a
new onc) and click Connect. Click OK to complete the login. You can connect to
several WorkSite Middle Tier servers at once.
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Auto Login on One or More WorkSite Middle Tier Servers

Once you have registered the WorkSite Middle Tier servers you need, you can
select which ones you want to log into automatically when you launch iManage
DeskSite. To select Auto Login servers, check the box next to the server name.
To deselect a server uncheck the box. Deselecting a server does not unregister
that server. See Figure 3.1,

Unregistering a Server

To wmregister a WorkSite Middle Tier Server without exiting iManage DeskSite
manually, open the Register/UnRegister dialog, highlight the desited server and
click the Unregister bution. Click Yes to confirm the unregister request.

Logging Out

You are automatically logged out of the WorkSite Middle Tier Server when you
exit or close iManage DeskSite.

Autosynchronize/Checkin Alert

If you have edited any portable or echo documents since the last time you ran
iManage DeskSite, the following alert message appears immediately when you
open iManage DeskSite. This message indicates that there are portable or echo
documents stored on your local drive that have been changed. To synchronize
these documents back to the database or check them in, click the Yes button in
the message box shown below. You have the option of copying them back as the
original document, importing them as new versions of the original document, or
importing them as new documents. If you click No and do not synchronize or
check in the documents in question, this message box appears again the next time
you launch iManage.

Figure 3.3: The Autosynchronize or checkin alert box appears to inform you that
you have portable or echo documents stored locally that need to be synchronized
back to the library.
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If you select Yes in the antosynchronize/checkin message box, then a dialog box
appears that allows you to check in any portable documents that you have
checked out or synchronize any echo documents that you edited. This dialog box
is shown in Figure 3.4.

If you want to show only documents that have changed, check the Show only
echo modified checkbox.

M arketing Travel Profile
" Marksting  iManage Travel Pali...

Figure 3.4: Checkin/Synchronize Documentis dialog box

You can also access the Checkin/Synchronize Documents dialog box from the
Options menu. From the Checkin/Synchronize Documents dialog box, you can
check in documents that you currently have checked out for portable mode or
synchronize echo documents that you edited off line.

To synchronize echo documents:
1. Click the Echo Documents tab.

2. Highlight the documents that you want to synchronize and click the Synch
button. '
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To check in checked out documents:

1. Click the Checkedout Documents tab,

2. Highlight the portable documents that you want to checkin and click the
Checkin button.

The Confirm Synchronize dialog opens.

q Confirm Sgnr_hunize

Figure 3.5: Confirm Synchronize dialog

Choose the appropriate option: Replace Original, New Version, or New Docu-
ment and click OK to synchronize the portable or echo document with the docu-
ment in the iManage library.

Searching for Documents

One of your first tasks in using iManage DeskSite will be to locate documents
that you want to work on. You can locate documents by:

»  Clicking the icon for a saved search . This will perform the search again
on the database and refurn documents that meet the search criteria.
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